
Oracle® Sales Contracts
Concepts and Procedures

Release 11i  

Part No.  B10679-01

June 2003



Oracle Sales Contracts Concepts and Procedures, Release 11i  

Part No.  B10679-01

Copyright © 2002, 2003 Oracle Corporation. All rights reserved. 

The Programs (which include both the software and documentation) contain proprietary information of 
Oracle Corporation; they are provided under a license agreement containing restrictions on use and 
disclosure and are also protected by copyright, patent and other intellectual and industrial property 
laws. Reverse engineering, disassembly or decompilation of the Programs, except to the extent required 
to obtain interoperability with other independently created software or as specified by law, is prohibited.

The information contained in this document is subject to change without notice. If you find any problems 
in the documentation, please report them to us in writing. Oracle Corporation does not warrant that this 
document is error-free. Except as may be expressly permitted in your license agreement for these 
Programs, no part of these Programs may be reproduced or transmitted in any form or by any means, 
electronic or mechanical, for any purpose, without the express written permission of Oracle Corporation.

If the Programs are delivered to the U.S. Government or anyone licensing or using the programs on 
behalf of the U.S. Government, the following notice is applicable:

Restricted Rights Notice  Programs delivered subject to the DOD FAR Supplement are "commercial 
computer software" and use, duplication, and disclosure of the Programs, including documentation, 
shall be subject to the licensing restrictions set forth in the applicable Oracle license agreement. 
Otherwise, Programs delivered subject to the Federal Acquisition Regulations are "restricted computer 
software" and use, duplication, and disclosure of the Programs shall be subject to the restrictions in FAR 
52.227-19, Commercial Computer Software - Restricted Rights (June, 1987). Oracle Corporation, 500 
Oracle Parkway, Redwood City, CA 94065.

The Programs are not intended for use in any nuclear, aviation, mass transit, medical, or other inherently 
dangerous applications. It shall be the licensee's responsibility to take all appropriate fail-safe, backup, 
redundancy, and other measures to ensure the safe use of such applications if the Programs are used for 
such purposes, and Oracle Corporation disclaims liability for any damages caused by such use of the 
Programs. 

Oracle is a registered trademark of Oracle Corporation. Other names may be trademarks of their 
respective owners. 



Contents

Send Us Your Comments ....................................................................................................................    v

Preface...........................................................................................................................................................    vii

1  Understanding Sales Contracts

1.1 Oracle Contracts Suite Overview........................................................................................    1-1
1.2 iStore Integration Overview ................................................................................................    1-4
1.2.1 iStore Shopping Cart Scenario......................................................................................    1-4
1.2.2 Telesales and Sales Online Scenario ............................................................................    1-5
1.2.3 Contracts and iStore Integration Flow ........................................................................    1-6
1.3 Quoting Integration Overview............................................................................................    1-7
1.3.1 Contract Creation from Quote .....................................................................................    1-7
1.3.2 Sales Order Creation from Contract............................................................................    1-7
1.3.3 Create Contract from Order..........................................................................................    1-8

2  Using Sales Contracts

2.1 Pricing a Service Item ...........................................................................................................    2-1
2.2 Creating a Contract from a Quote.......................................................................................    2-4
2.3 Creating a Sales Order from a Contract .............................................................................    2-7
2.3.1 Order Creation from Contract......................................................................................    2-7
2.3.2 Events to Create Orders ................................................................................................    2-9
2.4 Creating a Contract from an Order...................................................................................    2-11
2.5 Using Contracts with iStore ...............................................................................................    2-12
2.5.1 Customer Agrees to Terms and Conditions.............................................................    2-12
 iii



2.5.2 Customer Disagrees to Terms and Conditions ........................................................    2-13
2.5.3 Merchant Updates Terms and Conditions ...............................................................    2-14
2.5.4 Customer Agrees to Updated Terms and Conditions ............................................    2-15
2.5.5 Merchant Verifies Details............................................................................................    2-16

3  Implementing Sales Contracts

3.1  Setting Up Integration for iStore ........................................................................................    3-1
3.1.1 Setting Up Profile Options for Integration .................................................................    3-1
3.1.2 Setting Up Lookup Codes .............................................................................................    3-4
3.1.3 Verifying Workflow Setup............................................................................................    3-4
3.1.4 Setting Up Personnel .....................................................................................................    3-5
3.2 Setting Up Quote to Contract ..............................................................................................    3-7
3.2.1 Creating Quote to Contract Template .........................................................................    3-7
3.2.2 Setting Up for Contract Modifications ........................................................................    3-8
3.3 Setting Up Contract to Order...............................................................................................    3-8
3.4 Setting Up Order to Contract.............................................................................................    3-12
3.4.1 Setting Up the Article ..................................................................................................    3-12
3.4.2 Setting Up the Template..............................................................................................    3-13
iv



Send Us Your Comments

Oracle Sales Contracts Concepts and Procedures, Release 11i 

Part No.  B10679-01

Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this 
document. Your input is an important part of the information used for revision.

� Did you find any errors?
� Is the information clearly presented?
� Do you need more information? If so, where?
� Are the examples correct? Do you need more examples?
� What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document 
title and part number, and the chapter, section, and page number (if available). You can send com-
ments to us:

� Electronic mail: Contracts@oracle.com
� FAX: 650-633-3782 Attn: Oracle Sales Contracts
� Postal service

Oracle Corporation 
Oracle Contracts Core Documentation Manger
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

If you would like a reply, please give your name, address, telephone number, and (optionally) elec-
tronic mail address.

 If you have problems with the software, please contact your local Oracle Support Services
v



vi



Preface

Welcome to the Oracle Sales Contracts, Release 11i. This Concepts and Procedures 
provides information and procedures to help you work effectively with Sales 
Contracts.

This preface explains how Concepts and Procedures is organized and introduces 
other sources of information that can help you.

Intended Audience
This guide is aimed at the following users:

� Technical Service Representatives (TSR)

� Customer Service Representatives (CSR)

� System Administrators (SA), Database Administrators (DBA), and others with 
similar responsibility.

This guide assumes you have the following pre-requisites:

1. Understanding of the company business processes.

2. Knowledge of products and services as defined by your marketing policies.

3. Basic understanding of Oracle and Developer/2000.

4. Background in SQL, PL/SQL, SQL* Plus programming.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
vii



documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Structure
This manual contains the following chapters:

Chapter 1 Understanding Sales Contracts 
This chapter provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle applications.

Chapter 2 Using Sales Contracts 
This chapter provides process-oriented, task-based procedures for using the 
application to perform essential business tasks. 

Chapter 3 Implementing Sales Contracts
This chapter provides the procedures for setting up profile options, lookup codes, 
and Workflow required to implement the integration successfully.

Other Information Sources
You can choose from many sources of information, including online documentation, 
training, and support services, to increase your knowledge and understanding of 
Oracle Sales Contracts.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.
viii



Related Documentation
Oracle Sales Contracts shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Sales Contracts.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Sales Contracts 
(and any other Oracle Applications products). This guide also includes information 
on setting user profiles, as well as running and reviewing reports and concurrent 
processes.

You can access this user’s guide online by choosing ”Getting Started with Oracle 
Applications” from any Oracle Applications help file.

Documents Related to This Product

Oracle Contracts Core Implementation Guide
This implementation guide explains the tasks and considerations required to set up 
Oracle Contracts Core.

Oracle Contracts Core User Guide 
Use this guide to learn more about using Oracle Contracts Core functionality.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
ix



also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given in 
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.
x



Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.

Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle Workflow Guide
This guide explains how to define new workflow business processes as well as 
customize existing Oracle Applications-embedded workflow processes.You also use 
this guide to complete the setup steps necessary for any Oracle Applications 
product that includes workflow-enabled processes.

Oracle Applications Flexfields Guide
This guide provides flexfields planning, setup and reference information for the 
Oracle Sales Contracts implementation team, as well as for users responsible for the 
ongoing maintenance of Oracle Applications product data. This manual also 
provides information on creating custom reports on flexfields data.

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink
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Oracle Manufacturing APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Manufacturing.

Oracle Order Management Suite APIs and Open Interfaces Manual
This manual contains up-to-date information about integrating with other Oracle 
Manufacturing applications and with your other systems. This documentation 
includes APIs and open interfaces found in Oracle Order Management Suite.

Oracle Applications Message Reference Manual
This manual describes Oracle Applications messages. This manual is available in 
HTML format on the documentation CD-ROM for Release 11i.

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Sales 
Contracts and reach full productivity quickly. You have a choice of educational 
environments. You can attend courses offered by Oracle University at any one of 
our many Education Centers, you can arrange for our trainers to teach at your 
facility, or you can use Oracle Learning Network (OLN), Oracle University’s online 
education utility. In addition, Oracle training professionals can tailor standard 
courses or develop custom courses to meet your needs. For example, you may want 
to use your organization’s structure, terminology, and data as examples in a 
customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Sales Contracts working 
for you. This team includes your Technical Representative, Account Manager, and 
Oracle’s large staff of consultants and support specialists with expertise in your 
business area, managing an Oracle8i server, and your hardware and software 
environment.
xii



OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.
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About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
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Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
xiv



Understanding Sales Con
1

Understanding Sales Contracts

This topic group provides overviews of the application and its components, 
explanations of key concepts, features, and functions, as well as the application’s 
relationships to other Oracle applications.

1.1 Oracle Contracts Suite Overview 

Sales Contracts
Oracle Sales Contracts has “Contracts Core” functionality (i.e. Launchpad, 
Authoring, Execution, and so on) plus integration to Oracle iStore, Oracle Quoting, 
and Oracle Order Management. Oracle Sales Contracts allows users to automate 
their sales contracting process. Sales Contracts assists a company in enhancing its 
customer interactions by incorporating contract management into the 
opportunity-to-cash business flow. Oracle Sales Contracts takes advantage of 
existing Oracle sales management applications such as Oracle TeleSales, Sales 
Online, and iStore to complete the quote-to-contract-to-order flow.

Contracts Core
Oracle Contracts Core is designed for any company in any business that requires 
contracts independent of or in support of buying and selling activities.Whether the 
organization is the buyer or the seller, whether it issues contracts or receives them, 
Contracts Core automates the full life cycle of a contract. 

You can author, execute, and control non-industry specific contracts with Contracts 
Core, for both buy and sell contracts. It helps companies manage internal and 
external obligations, control daily deliverables, and be focussed on contractual 
goals. To ensure that you receive everything you negotiated for and provide 
everything you committed to delivering, Contracts Core helps track “hidden” 
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Oracle Contracts Suite Overview
deliverables enforceable requirements that may not be listed as a line item in a 
contract, but are described in terms and conditions. 

Oracle Contracts Core acts as a central repository for the collection and 
dissemination of contract information. It contains all data on terms and conditions, 
deliverables, and parties to the contracts. This repository is the key to provide a 
single source for all the information in any contract in your enterprise.

Contracts Core provides foundation functionality that other contracts modules may 
use, including Sales Contracts, Service Contracts, and Rights Contracts. This 
common functionality includes renewing or extending a contract, requesting a 
contract change, managing contract deliverables, and many others. You can record, 
group, organize, query contract data, and set up an automated approval process for 
your contracts.

For more information regarding Contacts Core features and functionality see, Oracle 
Contracts Core User Guide.

Service Contracts
Oracle Service Contracts enables you to create and manage service contracts, 
warranties, and extended warranties, providing visibility to contract entitlements 
and acting upon contractual commitments within the contract. 

Warranties and extended warranties are service contracts. When a customer orders 
a product that has an associated warranty or the customer orders an extended 
warranty with the product, Service Contracts automatically creates the warranty 
contracts based on the information from the sales order. When products are 
returned, replaced, upgraded, or transferred, the warranty and extended warranty 
are updated appropriately. In addition to defining service line items in your 
contract, Service Contracts enables you to define usage line items. For example, if a 
customer is renting a photocopier, the business can charge either on a per-copy 
basis or a fixed price. The business may set a minimum charge and vary the price 
depending on volume. Service Contracts supports bill settlement, invoice 
averaging, and billing profile definition. Service Contracts can receive physical 
counter readings from the installed base to determine the usage amount for actual 
billing. 

For more information regarding features and functionality for Service Contracts see, 
Oracle Service Contracts Concepts and Procedures.

Rights Contracts 
Oracle Rights Contracts addresses the business needs for the “Business Rights 
Management” domain. Business Rights Management is the systems and processes 
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Oracle Contracts Suite Overview
related to the acquisition and licensing of intellectual property. Business Rights 
Management processes are used to manage contracts and financial transactions 
captured in the contracts related to the acquisition or licensing of rights associated 
with intellectual properties used or created by a company or individual. 

Rights Contracts was initially released for 11.5.4. Rights Contracts offers an 
integrated approach to manage intellectual property and related rights which are 
represented by contracts. It provides users with a property catalog to capture meta 
information about intellectual property and to categorize and locate it in a 
centralized secure repository. It also provides users the ability to capture the rights 
to properties which are added through the Contracts module.

For more information regarding features and functionality for Rights Contacts see, 
Oracle Rights Contracts Concepts and Procedures.

Contracts Intelligence
Oracle Contracts Intelligence converts contracts data into contracts business 
knowledge and helps businesses to make informed tactical and strategic decisions. 
The primary integration point for this product is the contracts family. All data 
populated in Contracts Intelligence is based on the transactional data from Oracle 
Contracts. 

Contracts information is displayed in bins such as:

� Performance Measures

� Expired, Not Renewed

� Renewals by Status

� Forecast by Organization

For more information regarding features and functionality for Contacts Intelligence 
see, Oracle Contracts Intelligence Concepts and Procedures.
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iStore Integration Overview
1.2 iStore Integration Overview
The integration with iStore helps users who sell products and services through 
iStore by managing and coordinating the creation sales contracts. This integration 
enables:

� Standard terms and conditions displayed through iStore

� An active contract is created upon acceptance of the terms and conditions

� An entered contract created when the customer does not accept the standard 
terms and conditions

� Viewing new negotiated terms and conditions through iStore

1.2.1 iStore Shopping Cart Scenario
iStore allows customers to order items using a browser. Through the store the 
customer selects products, support, etc. iStore creates a quote with the customer’s 
selection. Once the customer finishes shopping he/she reviews the standard 
agreement. If the customer agrees with the standard agreement, he/she submits the 
order and iStore creates a sales order from the quote. You can set the system to then 
automatically create a contract with standard terms and that is approved and 
accepted.

In cases where the customer does not agree with the standard agreement, iStore 
allows the customer to specify the changes in a text field. iStore automatically 
triggers the contract creation based on a contract template for the standard 
agreement. The customer’s requests are stored as notes in the Interaction History 
module. An “entered” contract is automatically created, and a notification is sent to 
the sales representative and to the contract administrator. The quote is locked after 
the contract is created.

The contract administrator helps to determine which standard options to use in 
place of the standard agreement. The contract administrator drafts and approves 
the contract. Depending on the contract dollar amount, the contract administrator 
may need to submit the contract for a business approval. The sales representative is 
notified when the contract receives a final approval. 

Approved contracts are locked for changes until they are signed by the customer. 
The approved contract, implicitly signed by the supplier, is posted on the web for 
customer review.
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iStore Integration Overview
The customer has to access iStore to review and sign the new contract. The quote 
and the contract are unlocked once the contract is signed. The customer proceeds to 
the checkout once he accepts the new terms and conditions, and an order is created.

1.2.2 Telesales and Sales Online Scenario
The telesales agent or a sales representative creates a quote on behalf of the 
customer. The quote contains products, pricing, and shipping details. Once the 
quote is completed the agent prints the quote with the standard terms and 
conditions. The agent chooses a contract template that is linked to the quote. The 
agent sends the quote to the customer for approval. 

The agent creates the contract from the quote. When the customer accepts the quote 
and the standard terms and conditions a contract can be created as “approved and 
signed” when the agent places the order. 

If the customer does not accept the quote and/or the standard terms and 
conditions, a contract is created in “entered” status. The contract administrator and 
the agent are notified when the contract is created. The contract administrator 
updates the contract based on the requirements described in the Interaction History. 
Once the changes are incorporated, the contract is submitted for approval.

The agent and contract administrator receive a notification about the contract 
approval. After the approval the system updates the quote to reflect the latest 
changes to the contract. The negotiated contract is now printed and sent to the 
customer or published in iStore. The customer needs to sign the contract or accept it 
from the web. If the customer does not accept the contract and does not want to 
perform further negotiation, the contract and the quote are canceled. Otherwise, the 
contract is signed and the agent can place the order. 
Understanding Sales Contracts 1-5



iStore Integration Overview
1.2.3 Contracts and iStore Integration Flow
The following diagram illustrates selling products and services when a contract is 
required:
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Quoting Integration Overview
1.3 Quoting Integration Overview
You can use Oracle Sales Contracts to perform the following processes:

� Contract Creation from Quote

� Sales Order Creation from Contract

� Create Contract from Order

1.3.1 Contract Creation from Quote
This functionality supports the creation of a contract from a quote. When a quote is 
created in Quoting, a process can be initiated by you to create a contract in the 
Entered status. All relevant information from the quote, including lines and pricing 
details, party information, shipping and billing information are passed to the 
contract. 

In this scenario, a user could create a contract directly from a quote. This scenario is 
possible when a customer does not agree to the standard terms and conditions 
offered in the quote and requires additional or revised terms and conditions, or 
when a sales agent requires additional flexibility when negotiating a deal. A 
contract can be created from the quote, and used as the primary negotiating tool. 

All required information is entered in the quote, item information is added to the 
cart, and the quote is saved. The user can then create a new contract, picking from a 
list of contract templates. The contract is created with the status of Entered, and the 
quote number that this contract was created from is referenced in the contract. 

1.3.2 Sales Order Creation from Contract
Contract Administrators may require the ability to create an order directly from a 
contract, rather than from a quote. Additionally, when you create a contract from a 
quote, and use the contract as the primary tool for negotiations, the outcome would 
be to either cancel the contract, or create an order from the contract. 

This integration enables you to create a standard order from an “active” contract. A 
new concurrent process is added, called “Order creation from Contract”. Once 
initiated, you are prompted to provide the contract number from which to create an 
order. The new order contains all relevant information from the contract, including 
customer, shipping, billing details, line item, quantity, and pricing details. The new 
order is created with the Entered status. The contract is updated to include the new 
order number.
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Quoting Integration Overview
1.3.3 Create Contract from Order
Order Management sells products and services that may need a contract to be setup 
between more than one Parties. In a typical business scenario, a sales contract is 
created before order is placed. It contains the terms and conditions for the items 
being bought, and needs to be approved by the supplier and signed by the 
customer before booking the Order. Most of the time the supplier (i.e. the merchant) 
has a pre-defined standard terms and conditions that are used to create a contract 
automatically. If the customer (i.e. the buyer) agrees, then an order is placed. If not, 
then the contract needs to be negotiated between the customer and the supplier’s 
contract specialist. Once both parties agree, the order can be placed.

However, there is a need to create a sales contract from already fulfilled orders so 
that all existing paper contracts in an organization can be stored in Oracle 
Contracts. This provides online access to all the Contracts which were signed and 
agreed upon before placing the order. This will also help them generate more 
revenues by identifying the contracts that can be renewed and thus will create more 
business opportunities. This integration gives contract users the facility to migrate 
existing fulfilled orders to sales contracts which helps manage business in a 
profitable and efficient manner.
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Using Sales Contracts

This chapter covers the following topics:

� Pricing a Service Item 

� Creating a Contract from a Quote

� Creating a Sales Order from a Contract

� Creating a Contract from an Order

� Using Contracts with iStore

2.1 Pricing a Service Item 
When authoring a sales contract a "Service Item" is selected as the Line Style. You 
can add multiple lines to the Sublines tab corresponding to the top line. For 
example, a top line has a Service Item named "Extended Notebook PC Service". 
From the Sublines, you can create multiple lines for either Covered Line or Covered 
Product.   Only the following seeded Line Styles for the Sublines tab are supported 
when creating a sales order from a contract:

� Covered Line refers to Non Service Items included in the top line of the 
contract. The List of Value (LOV) of Item for covered line includes the 
following: Name, Line Number, Quantity, and Unit of Measure (for a 
Non-Service Item in top line).

� Covered Product includes the product bought by the customer as included in 
Oracle Install Base application.
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Pricing a Service Item
The LOV of Item for Covered Product includes the following to uniquely 
identify the product: Name, Description, Current Serial Number, Reference 
Number, Quantity, Unit of Measure, and Original Net Amount. 

If the subline for a service item has a user-defined Line Style, this subline will not 
be considered during the sales order creation. 

Pricing Scenario for Service Item
The unit price for the subline of a service item is calculated based on the unit price 
of the service times its duration. The list price of the subline item is calculated based 
on the unit price for the subline times its quantity. The net price of the subline is 
calculated based on list price times its adjustment percentages (Adj %).

For example:

Representation of the above scenario in the Contracts Authoring form:
 

Note: In order to see the LOV of Item for a Covered Product (from 
Oracle Install Base), the Customer Account rule in a Billing Rule 
group needs to be defined first.

Customer Account rule = customer name 

Line Items Name Quantity Unit Price

Service Item Gold Support 2 years $500.00

Covered Product #1 Oracle 8i 3 licenses       

Covered Product #2 Forms 6i 2 licenses      

Line Name Qty UOM Unit Price List Price Net Price

Top Line Oracle 8i 3 Each $50,000.00 $150,000.00 $150,000.00

Top Line Forms 6i 2 Each $10,000.00 $20,000.00 $20,000.00

Top line Gold 
Support

2 Year Null $5,000.00 $5,000.00

Subline Gold 
Support 
Oracle 8i

3 Each $1,000.00 $3,000.00 $3,000.00
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In this example, the List Price and Net Price columns are calculated as follows: 

Service Unit Price Xs Service Duration Xs Number of Covered Products

Gold Support for Oracle 8i = $500 Xs 2 years Xs 3 licenses = $3,000.00

Gold Support for Forms 6i = $500 Xs 2 years Xs 2 licenses = $2,000.00

This is also consistent with Order Management requirements. A sales order from 
this contract has two lines, one for Gold Support for Oracle 8i for $3,000.00 and 
another for Gold Support for Forms 6i for $2,000.00. 

This functionality is supported only for the seeded Line Style "Service Item" and its 
"Covered Product" and "Covered Line" Line Styles (Sublines).

Changes to Line Items Tab for Service Items
When Service Item is selected as the Linestyle for the top line and values are 
selected for Qty and UOM, the Unit Price, List Price, Adj%, and Net Price for the 
top line are disabled and cannot be updated by the user. 

The List Price and Net Price are rolled up automatically from their respective 
sublines. Net Price is calculated based on List Price times Adj%. The Unit Price for 
the Service Item is not displayed in the Contracts Authoring form except when the 
user enters "1" for Qty in top line, then the Unit Price appears in the Sublines tab. 

Example 1:
Line Items

� Line Style = Service Item 

� Name = Extended Notebook PC Service 

� Qty = 1 

� UOM = Year 

Sublines

� Line Style = Covered Line 

� Name = Sentinel Standard Desktop

Subline Gold 
Support 
Forms 6i

2 Each $1,000.00 $2,000.00 $2,000.00

Line Name Qty UOM Unit Price List Price Net Price
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� Qty = 2 

� UOM = Each 

� Unit Price = $400.00

� List Price = $800.00

In this example, the Unit Price of $400.00 does not appear in the top line. However 
the Unit Price of $400.00 appears in the Sublines tab because"1" was entered for Qty. 
The List Price appears in both Sublines and Line Items.

Example 2:
Line Items

� Line Style = Service Item 

� Name = Extended Notebook PC Service 

� Qty = 2 

� UOM = Year 

Sublines

� Line Style = Covered Line 

� Name = Sentinel Standard Desktop

� Qty = 2 

� UOM = Each 

� Unit Price = $800.00

� List Price = $1,600.00

In this example, the Unit Price of $400.00 does not display. The "Actual" Unit Price 
can be calculated by: Unit Price/Qty ($800.00 /2 = $400.00). The List Price appears 
in both Sublines and Line Items.

2.2 Creating a Contract from a Quote
Use this procedure to create a contract from a quote in Oracle Quoting. 

References
� Oracle Quoting Concepts and Procedures 

� Oracle Contracts Core User Guide, Creating a Contract Template.
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Prerequisites
� To create a contract from a quote, in Oracle Quoting, the ASO: Enable User 

Contracts profile option should be set to Yes. 

� A contract template must be set up as follows:

� Contract for Sales as the category

� Sell as the Intent

� Party roles defined

� The System Profile Option "OKC Default Contract Group" should be set to the 
Contract Group where the created contract is to be placed.

� Sales Contract Manager responsibility needs to be defined for the Contract for 
Sales category with “Modify” or "Read" access.

� Status and Operations must be set up for the Contract for Sales category.

� A quote must be created having the following as a minimum:

� Customer

� Account

� Item(s)

� Bill to Address

� Ship to Address

� Quote Number

� After a contract is created from a quote and a contract template, the status of the 
original quote can be updated if the contract, through the workflow approval 
process, is approved or rejected, or manually cancelled. The quote status is then 
displayed as Approved, Contract Pending, Contract Canceled, or Contract 
Required respectively. For contracts that are approved or rejected, as part of 
approval process, the quotes are also automatically updated. For cancelled 
contracts, the status change is reflected in the quote only if a specific condition 
has been attached to the contract. It is recommended to attach the condition to 
the template so that the condition is automatically assigned to any new contract 
created from that template. The condition that should be set up in the template 
is:

� Name: Contract Cancelled

� Condition type: 'Action' as 'Contract Status Change' 
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� Expression: ’CONTRACT CURRENT STATUS TYPE = CANCELLED’ 

� Outcome: ’Notify Sales Rep’. The ’Notify Sales Rep’ outcome will call an 
Order Capture API to update the quote status.

� Parameter/Action Attribute: 

a. ’P_CONTRACT_ID = CONTRACT ID’ 

b. ’P_CONTRACT_STATUS = CONTRACT CURRENT STATUS CODE’ 

�  In addition to setting the condition in the template, verify that:

� The workflow background process of item type ’Contract Alert’ is running

� The ’Listener for Outcome Queue’ and the ’Listener for Events Queue’ are 
running

� In the Contract Events \ Events Controller form, query the above listeners 
and verify the Quote status setup in Order Capture allows the ’Contract 
Pending’ to ’Contract Canceled’ Status transition. 

Steps
1. From the Quoting Sales Manager responsibility, select Quoting. The Quoting 

form opens.

2. Query for an existing quote or create and save a new quote. 

3. Navigate to Actions > Contract to open the Contract Detail Information 
window.

4. In the Contract Template field, select a template

5. Select of one the following radio buttons:

� Use default terms and conditions defined in contract template: by selecting 
this button, no contract is created for this options, instead users can only 
view terms and conditions of contract template by clicking the Review 
Terms button. 

� Request contract creation if you need to negotiate terms and conditions: By 
selecting this button, you can enter a note for the contract administrator and 
request modification to terms and conditions. A workflow notification 
sends your note to the contract administrator. The contract administrator 
can access the note from the Inbox region of the Contract Launchpad 
window. The contract administrator is set up in the profile option "OKC: 
Default Contract Administrator for Notifications".

6. Switch responsibilities to Contracts Manager 
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7. Navigate to Launch Contracts > Contract Navigator tab.

8. Find the new contract within the appropriate Contract Group.

9. Verify within the Contract Summary tab the text “Created from quote number 
xxxxx,version x” appears in the Short Description field. Lines, pricing, and Rule 
information from the quote should populate the new contract (Status should be 
“Entered”).

10. Close the form.

2.3 Creating a Sales Order from a Contract
Choose one of these procedures to create a sales order in Oracle Order Management 
from an active contract:

� Use the  "Order Creation from Contract" procedure when the contract does not 
have any event which automatically creates a sales order (as an outcome) in 
Oracle Order Management.

� Use the  "Events to Create Orders" procedure when a contract event has an 
outcome to automatically create a sales order in Oracle Order Management. 

� If you are planning to use Service Items as a Line Style, you should review 
Service Item Pricing, Oracle Contracts Core User Guide. 

2.3.1 Order Creation from Contract

Reference
For the procedures on creating, authoring, and approving contracts see, Oracle 
Contracts Core User Guide.

Prerequisites
Only an “Active” contract is used having the following:

� Sales Contracts as the category (See Guidelines below if you use a different 
category)

� At least one line

� Sell as the intent

� Issue as the perspective

� Billing and Shipping rules defined
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� Parties defined

� Belongs to operating unit of the responsibility user is logged in

Steps
1. From the Contracts Manager responsibility, navigate to Control > Requests > 

Run.

2. In the Name field, select the “Order Creation from Contract” name.

3. Select a category from the Parameters window.

4. Select the Contract Number and click OK. The LOV shows all active contracts 
that have been created manually or from a quote. It will not show contracts that 
have already had an order created against them. If the profile "OKC: Allow 
Order Creation from Contracts created by Quotes" is set to "No", then contracts 
created from quotes will not be included in the LOV.

5. Click Submit and note the Request ID number.

To view completion of the request, open the Completed Requests window by doing 
the following:

6. Navigate to View > Requests. The Find Requests window opens.

7. Query the Request id number. The Requests window opens.

8. If request was completed with normal status, click View Output to get order 
number information and proceed to next step. If not completed, click the 
Request Log button to view the report. Identify and fix errors and repeat this 
procedure.

To view the order details, open the Contract Authoring window.

9. From the Contracts Manager responsibility navigate to Launch Contracts > 
View > Find.

10. Enter the contract number and click Search.

11. Right click contract and select Open.

12. View the order creation information in the Comments region of the Summary 
tab.

To view details in Order Management, open the Contract Execution window.

13. From the Contracts Manager responsibility, navigate to Launch Contracts and 
click Open > Contract Navigator tab.
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14. Select the Contract Group.

15. Select the contract and right click mouse to select the Execution from pop up 
menu.

16. Select the Related Objects tab. You can view the sales order details. You cannot 
make any updates in the read-only mode.

17. Close the form.

Guidelines
The category seeded with order creation is Sales Contracts. For a status of "Active" 
the "Integration to Order Management" is seeded for this category. If you need to 
create an order for another category or status, this operation is done manually using 
the Status and Operations form. See Contracts Core Implementation Guide, Setting Up 
Status and Operations.

2.3.2 Events to Create Orders

Prerequisites
Ensure the following concurrent programs are running:

� Listener for Outcome Queue

� Listener for Events Queue

� Workflow Background Process

To create orders for contracts that contain configured items, set the OM: Use 
Configurator profile option to "Yes".

Steps
1. From the Contracts Manager responsibility, create a Sales Contract using Sales 

Contract as a category.

2. Define the contract (Summary, Parties, Line Items, and so on).

3. Click Conditions:

� If you choose a seeded condition to automatically create an order when the 
contract is signed, navigate to Actions > Copy from Template. The Template 
window opens.

�  Select Contract Signing Template for Template Name.
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� Click OK.

� If you choose to create a condition, then select an action, outcome, and 
required outcome parameters. See Oracle Contracts Core User Guide, Entering 
a Condition.

4. Save the contract.

5. Submit contract for the QA Check.

6. If contract passed the QA Check, submit for approval. 

7. Approve contract.

8. Sign contract. Upon signing, the Event engine submits a concurrent request for 
the order creation. However, the Request ID will not display after signing the 
contract.

9. Navigate to View > Requests. The Find Requests window opens.

10. Select Specific Request.

11. In the Name field, enter "Order Creation from Contract".

12. Click Find. 

13. If the request is successfully completed with status of normal, click View 
Output. This provides the contract and order number information. 

14. Select the contract from the Contract Navigator tab.

15. Right click the contract and select "Execution" from the pop-up menu. The 
Contract Execution window opens.

16. Select the Related Objects tab. The Document Type, Document, Description, and 
Order Details region fields should contain sales order related information. From 
the Summary > Text subtab, (Contracts Authoring window) the Order Creation 
Date and Order Number appear in the Comments region.

17. Close the form.

Guidelines
Contracts created from a Quote or iStore are frozen and cannot be modified (except 
for Articles and Section). 

If the profile "OKC: Allow Order Creation from Contracts created by Quotes" is set 
to "No", you cannot create a sales order for contracts created from quotes. In this 
case only a quote is used to create an order. 
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If you set up a "Notification for the Outcome", you will need to run the "Send Task 
Notifications" concurrent request.

2.4 Creating a Contract from an Order
Use this procedure to create a contract from an existing sales order.

Prerequisites
Sales Orders must have a status of "Closed".

You can only create Sales Contracts orders belonging to the same operating unit that 
is associated to the responsibility your are using. 

A contract template must be created that includes Party Roles, Sell as Intent, and 
Contract for Sales as Category.

Sales Contract Manager responsibility needs to be defined for the Contract for Sales 
Category and with Modify or Read access.

Steps
1. From the Sales Contracts Manager responsibility, select Control > Requests > 

Run.

2. In the Request Name field, select the “Create Contract from Orders”. The 
Parameters window opens.

3. Select the Customer Account. 

4. Select the appropriate sales order.

5. Select the appropriate contract template.If no template is specified in the 
Parameters window, the template specified in profile "OKC: Contract Template 
for standard terms and conditions" is used.

6. Select a group name. This determines where the contract will be placed.

7. Select an Order Type.

8. Select one of the following for Contract Start Date:

� Booked Date

� Ordered Date

� Pricing Date

9. If you want the QA Check to be Applied, then select "Yes".
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10. Click OK.

11. Click Submit and note the Request ID number.

To view completion of the request, open the Completed Requests window by doing 
the following:

12. Navigate to Control > Requests > View.

13. Click View Log to review details.

14. Click View Output to display the list of contracts created.

2.5 Using Contracts with iStore
The following procedures are based on common scenarios with Sales Contracts and 
iStore integration:

� Customer Agrees to Terms and Conditions

� Customer Disagrees to Terms and Conditions

� Merchant Updates Terms and Conditions 

� Customer Agrees to Updated Terms and Conditions

� Merchant Verifies Details

2.5.1 Customer Agrees to Terms and Conditions
This procedure is used by the customer for selecting items for purchase, registering 
(if new user), and when he/she agrees with the terms and conditions of the 
contract.

Steps
1. Log in to iStore. 

2. Choose a specialty store. 

3. Browse and select to purchase items by placing the items in a cart. Click Add to 
Cart.   The Shopping Cart window opens

4.  Review the items in the cart and the pricing information. 

5. Click Checkout.

6. Enter your User Name and Password at the Sign In window. If you are a new 
user, complete the following:
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a. Complete the new user registration. The mail address specified is used to 
notify you in the event the terms and conditions have been changed and are 
ready to be reviewed.

b. Complete Shipping Information.

c. Click Continue.

d. Enter Payment and Billing information.

e. Click Continue.

7. Select Review Terms and Conditions.

8. If you agree with the Terms and Conditions, click I agree - Continue Checkout. 
An order is created and a contract with status of “Active” is tied to this order. If 
you disagree, proceed to the next section Customer Disagrees to Terms and 
Conditions”. 

9. Click I agree to Terms and Conditions. Place Order. An order is created and a 
contract with the status of “Active” is tied to this order.

2.5.2 Customer Disagrees to Terms and Conditions
This procedure is used by the customer in the event he/she does not agree with the 
contract terms and conditions.

1. If store and item not selected, follow steps 1-7 listed in Customer Agrees to 
Terms and Conditions.

2. If you disagree to the contract terms and conditions, click I disagree - Need 
Assistance. 

3. Choose one of the following (Either way, an e-mail notification will 
automatically be sent to the sales representatives, notifying them that you have 
disagreed to the standard terms and conditions of the contract, and need 
assistance):

� “I know my sales representative’s contact information”. Please send this 
change request. If you select this option, enter the sales representative’s 
e-mail address.

� “Please route this change request to my sales rep.; I do not have the contact 
information”.

4. Enter a cart name in the Save Your Cart field.
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5. Explain why you do not agree to the standard terms and conditions, or why 
you need additional help with your order. 

6. Click Submit Request. A contract in “Entered” status is automatically created. 
This contract is created from a contract template. The Request Confirmation 
window opens. This portion of the customer interaction is complete. 

2.5.3 Merchant Updates Terms and Conditions
The sales representative would receive an e-mail notification regarding the 
customer’s account status, in this case, the customer did not agree with the standard 
terms and conditions, and is requesting assistance with the order. The sales 
representative would speak with the Contract Administrator about changing the 
terms and conditions of the contract per the customer’s request. 

The Contract Administrator would also receive a notification regarding the new 
contract that was created relating to this customer. 

Steps
1. From the Contracts responsibility, (N) Launch Contracts > (T) Launchpad. 

Right click the Inbox, and choose Find from the pop-up menu. 

2. Select the Notification Type of Contract Alert. 

3. Click Find.

4. Select the notification regarding the new contract created for this specific 
customer. Click Respond. 

5. Select the Subject link in the Worklist to view the Notification Details.

6. From the Launchpad, select the Contract Navigator tab. 

7. Find the contract.

8. Double-click the contract to open the Contract Execution window. 

9. Select the Communications tab. 

10. Find and highlight the interaction. 

11. Click Open to view customer interaction. 

12. View the details of the interaction for the customer’s comments.

13. Click OK. Close the Execution form. 
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14. From the Contract Navigator, right click the contract number and select Open. 
Notice from the contract Summary tab, the status is “Entered” and the quote 
number from iStore has been included. 

15. Select the Parties tab and notice the customer name has been populated from 
the customer interaction from iStore. Lines in the Line Items tab have also been 
populated from the customer shopping cart.

16. Select the Articles tab.

17. Select the appropriate article to change. 

18. Click Show Text.

19. Edit the article according to the customer’s requirements. 

20. Click OK. 

21. Click Submit for Approval. The QA Results window will show whether the 
test was completed successfully or not. 

22. If all checks succeeded, click Continue Approval. A window will appear with 
the message, “Process Started Successfully.” Click OK.   Another window will 
appear with the message, “The process Approval Process is active for this 
contract. You cannot change this contract.” Click OK and close the contract. The 
person who is setup as the Contract Approver will get a notification of this 
pending approval. 

23. Navigate to the Launchpad tab of the Inbox region and click Find to search for 
Contract Approval notification. 

24. Select the contract from the list.

25. Click Respond. 

26. Click Approve and close the Worklist. 

2.5.4 Customer Agrees to Updated Terms and Conditions 
Upon contract approval, the customer will get an e-mail notification that the terms 
and conditions have been changed and are available for review. 

Steps
1. Log into iStore.

2. Click the Shopping Cart icon. The Saved Carts window will list all existing 
saved carts. 
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3. Select the cart name that has a contract number attached with a contract status 
of “Approved”. 

4. Review the order details again.

5. Click Checkout. The Review Order Details And Confirm window appears.

6. Select Review Terms and Conditions to review the modified terms and 
conditions.

7. Click I agree-Continue Checkout. The Review Order Details and Confirm 
window opens.

8. Click I agree to Terms and Conditions. Place Order. This will place the order. 
The Order Confirmation window displays the new order number for this order. 

2.5.5 Merchant Verifies Details
After customer has placed the order, the merchant can verify the details of the 
contract.

Steps
1. From the Navigator, find the contract.

2. Right click the contract and select Open.

3. Review the following:

� Contract status has changed to Active

� Date Signed field has been populated. 

4. From the Navigator, right click the contract and select Execution.

5. Select Related Objects 

6. View the Quote Number and Order Number details. 

7. Close the contract.
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Implementing Sales Contracts

This topic group provides general descriptions of the setup and configuration tasks 
required to implement Sales Contracts successfully:

� iStore Integration

� Quote to Contract

� Contract to Order

� Order to Contract

3.1  Setting Up Integration for iStore
Setting up the integration for Contracts and iStore consists of the following tasks:

� Setting Up Profile Options for Integration

� Verifying Workflow Setup

� Setting Up Personnel

3.1.1 Setting Up Profile Options for Integration

 Sales Contract Profile Options

Steps
Use the following procedure to set up Contracts profile options:

1. Login to Oracle Applications and choose the System Administrator 
responsibility. 

2. Navigate to Profile > System. The Find System Profile Values window opens. 
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3. Enter “%OKC%” in the Profile field.

4. Click Find. 

5. Set up the following profiles, (in any order) to enable the iStore and Oracle 
Contracts integration:

Option Value Description

OKC: Contract 
Approver

<User name> This profile should be set to the person 
authorized to approve contracts; after 
contracts are submitted for approval, they 
will be routed to this person for approval.

OKC: Contract template 
for standard terms and 
conditions

<Contract 
template 
name>

When an iStore customer uses Checkout, the 
terms and conditions are viewed and the 
subsequent contract is created for that order 
is originated from the contract template 
defined in this profile option. Choose from 
the list of values.

OKC: Default contract 
administrator for 
notifications

<User name> This profile should be set to the person who 
will receive a notification that a contract in 
“Entered” status was created from iStore. This 
will occur when the customer disagrees to the 
standard terms and conditions.

OKC: Default group for 
contracts created from 
quote

<Contract 
group name>

This profile should be set to a contract group. 
Contracts created via the iStore flow will 
automatically be organized in this contract 
group found in the Contract Navigator. This 
takes precedence over any groups set up in 
the template. The contract group must first be 
created before specifying that group name 
here. 

OKC: Notify 
administrator about new 
contract from iStore

Yes/No Set this to “Yes” if you want the Contract 
Administrator to receive notifications for 
every contract created from iStore when the 
customer disagrees with standard terms and 
conditions.
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iStore Profile Options 
If you are integrating Oracle iStore with Oracle Contracts, you need to set up Oracle 
iStore and set the iStore profile options. The Oracle iStore profile option, “IBE: 
Create Standard Contract” specifies whether a contract is created when a customer 
agrees to standard terms and conditions. If the profile is set to “Yes”, a contract is 
created with a status of “signed” when the customer places the order. If the profile 
is set to “No”, a contract is not created. The profile default value is “Yes”.

For specific instructions on iStore setup steps, reference the Oracle iStore 
Implementation Guide. 

Quoting Profile Options
If you are integrating Oracle iStore with Oracle Contracts, you will need to set up 
Oracle Quoting and set the Quoting profile options. The Oracle Quoting profile 
option, “ASO: Enable Use Contracts” activates integration with Oracle Contracts. 
“Yes” activates the integration; the default profile is “No”. 

For specific instructions on Quoting setup steps, reference the Oracle Quoting 
Implementation Guide. 

OKC: User Directory <Directory 
path>

This profile specifies the directory of the 
HTML style sheet. This file is for formatting 
the Terms and Conditions appearing in iStore. 
The value is the location of the style sheet file, 
and should look like this: 
“/u01/db/kstoreit/xsl/”; the specific 
location will depend on each installation. The 
directory path should always end “/” or 
whatever directory separator specific to the 
platform.The database administrator should 
have read access to this file.

OKC: Allow order 
creation from 
contracts created by 
quote:

Yes/No This profile provides users with the 
flexibility to determine whether the 
entire contract created from a quote can 
be modified or the contract is read-only. 

Option Value Description
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3.1.2 Setting Up Lookup Codes
The Application Object Library Lookups window is used when identifying and 
defining Lookup Codes. 

From the Corporate Contracts Manager responsibility, select Setup > Others > 
System > Lookups.

3.1.3 Verifying Workflow Setup
The Workflow Background process must be running to ensure Contract Alerts are 
being sent to the contract administrator when a contract is created from iStore, and 
to ensure that the Contract Approval process will work.

For detailed instructions on setting up Oracle Workflow, reference the Oracle 
Workflow Guide. 

To verify the Workflow Background process is running do the following:

Steps
1. Login to Oracle Applications and choose the System Administrator 

responsibility.

2. Navigate to Requests > Run.

3.  Select the Single Request option and click OK.

4. In the Name field, select Workflow Background Process. The Parameters 
window opens.

5. Choose “Contract Alert” from the Item Type LOV. 

6. Choose “Yes” from the Process Deferred LOV. 

7. Choose “Yes” from the Process Time-out LOV. 

8. Click OK. 

9. Click Submit. 

10. From the Navigator, select View. The Requests window should return a list of 
subsequent requests that have been entered or completed for the Workflow 
Background process. 

Code Description

OKC_ISTORE_ART_TITLE Specifies meanings for the title of the Terms 
and Conditions page.
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If the Workflow Background process is not running, you can run the process 
manually, or schedule the process to run automatically.

11. Repeat steps 1-8 above. 

12. Click Schedule.

13. Select Periodically.

14. Select Minutes from the Re-run Every LOV.

15. Click OK.

3.1.4 Setting Up Personnel
When you are integrating Oracle iStore with Oracle Contracts, the Contract 
Administrator and Sales Representative must be set up. The following setup steps 
will need to be completed:

Creating Employee Record

Steps
1. From the Human Resources Management System (HRMS) responsibility, (N) 

People > Enter and Maintain.

2. Create an employee record. Set up the Contract Administrator and Sales 
Representative as Employees. 

3. Select the Office Details.

4. Enter the employee’s e-mail address. 

5. From the CRM Resource Manager responsibility, (N) Maintain Resources > 
Resources.

6.  Create a user name and tie the user name to the employee. 

7. Assign a role to the user name (Contract Administrator and Sales 
Representative roles). 

8. (N) Import Resources.

9. Import the user as a CRM resource.

For more details on this setup please see the following reference:

� Oracle CRM Foundation Implementation Guide 
Implementing Sales Contracts 3-5



Setting Up Integration for iStore
Specify the Sales Representative for Notifications 
To enable notifications to be sent to Sales Representatives when a customer 
disagrees with standard terms and conditions, or when standard terms and 
conditions are changed and ready for the customer’s approval, the following setup 
is required:

Steps
1. From the HRMS responsibility, (N) Work Structures > Organization > 

Description. The Find Organizations window opens.

2. Select a Name from the LOV to search for the Operating Unit for a specialty 
store. 

3. Click Find. The Organization window opens.

4. Select the Operating Unit from the Organization Classification region.

5. Click Others. The Additional Organization Information window opens.

6. Select the Default Notify User from the LOV and click OK.

7. Place the cursor in the Default Notify User field. The Default Notify User 
window opens.

8. Enter the user name of the sales representative (uppercase) in the Contracts 
field. This will be the person who will receive notifications when a customer 
disagrees with the standard terms and conditions and when terms and 
conditions are modified and approved for customer review. 

9.  Click OK. 

Setting Up Notification Mailer Process

Steps
1. From the System Administrator responsibility, (N) Requests > Run.

2. Select Notification Mailer for the request. The Parameters window opens.

3. Enter “<FND_TOP>/resource/wfmail.cfg” for the location of the wfmail.cfg 
file located in the FND_TOP resource directory. For example, 
“/afrz/crmcon/kstoreit/fnd/11.5.0/resource/wfmail.cfg”.

For more details for this setup see, Oracle iStore Implementation Guide.
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3.2 Setting Up Quote to Contract
Setting up Quote to Contract include:

� Setting Up Category Access to a Responsibility: This is not a security feature, it 
is used to filter articles by category for Authoring. The category used is 
KFORQUOTE and the Class is “Contract for Sales.” See Oracle Contracts Core 
Implementation Guide, Setting up a Category

� Setting Up Status and Operations: For the “Contract for Sales” category the 
operations are not seeded for the status types. See Oracle Contracts Core 
Implementation Guide, Setting up Status and Operations

� Creating Contract Groups: You may want to set up a Contract Groups folder for 
placing contracts created from a quote. See Oracle Contracts Core User Guide, 
Maintaining Contract Groups 

� Creating a Quote to Contract Template: You need to create a contract template 
for creating a contract from a quote. See Creating Quote to Contract Template

� Setting up profile options:

� "OKC: Allow Order Creation from Contracts Created by Quote" profile 
option. See Setting Up For Contract Modifications

� “OKC: Default group for contracts created from quote” profile option 
should be set to a contract group. This overrides the group chosen in the 
template. See Sales Contract Profile Options

3.2.1 Creating Quote to Contract Template

Steps
1. From the Contracts Manager Responsibility, navigate to Launch Contracts > 

Tools > New.

2. Select Contract for Sales as the category.

3. Enter header information:

� Select Sell for Intent

� Select Issue for Perspective

4. Enter summary information:

� Select QA Checklist
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� Select Groups

� Select Approval Workflow

5. Select Party Roles (2). Only the party role from this template is used when 
creating a contract from a quote. The party name is not used. Contact 
information will come from the quote.

6. Assign applicable rules such as Billing, Notification, and so on. Rules like bill-to 
and ship-to, if not entered from the template, are defaulted from the category.

7. Save the template.

3.2.2 Setting Up for Contract Modifications 
This feature provides users with the flexibility to determine whether a contract 
created from a quote can be modified or it is a read-only contract. If the contract can 
be modified, then orders in Order Management can be created from the same 
contract. This feature uses an existing profile option to provide users with a setup 
option to elect how the quote to contract integration should behave. 

The OKC: Allow Order Creation from Contracts Created by Quote profile defaults 
to null, or the user can set this to "No" or to "Yes". A null setting behaves the same 
as a "Yes" setting. By choosing "No", users elect to make the contract read-only, and 
only certain attributes of the contract, including articles, sections, and parts of the 
summary can be modified; all other attributes are frozen. A null or "Yes" setting 
allow all attributes of the contract created from a quote to be modified, assuming 
the user has appropriate privileges using an existing security model. 

For the procedure to set this option see Sales Contract Profile Options

3.3 Setting Up Contract to Order
This procedure enables you to create a sales order from any existing category (and 
any new category you define as well) from a contract class such as corporate, sales, 
and master agreement (OKC and OKO classes). This is done by associating an 
operation called "Integration with Order Management" with a designated category. 

This procedure also enables you to create a sales order from any stage of the 
contract life cycle by using Status and Operations to associate a status and category 
with the "Integration with Order Management" operation. The QA check ensures 
that the integration operation has been associated with the category of contract 
being checked. 
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Prerequisites
If you want to create a new category for this operation, then the category should be 
defined first. 

Steps
1. From the Contracts Manager Responsibility, navigate to Setup > Contract > 

Categories and Sources > Define Categories. The Category form opens.

2. Select the Rules tab.

3. If you author a contract for a given category and have a situation where a 
particular contract of that category should not be used for the integration, then 
select the Operation Exclusion Rule Group. However, this does not prohibit the 
integration operation for other contracts belonging to that same category. The 
default of any integration operation associated to a category will enforce the 
corresponding QA API to be executed against the contract.

4. Close form and save your changes.

5. Navigate to Setup > Contract > Status and Operations. The Status and 
Operations form opens. 

6. Select a Status Type from the LOV.

7. Select a Status from the Statuses region.

8. Select a Category from the Allowed Operations by Category region.

9. In the Operation field, select the "Integration with Order Management" option.

10. Repeat steps 5-8 for other Statuses and Status Types.

11. Close the form and save your changes.

Guidelines
When using the integration operation with Order Management, the following 
guidelines apply:

� Ensuring there are at least two party roles in contract. The JTF Object’s source 
table of party role source (for intent "Sell") are OKX_PARTIES_V (for Buyer) or 
OXK_LEGAL _ENTITIES_V (for Seller) or OKX_ORGANIZATIONS_DEFS_V 
(for Seller) respectively.

� Ensuring that when a top line style is added to a category it is sourced from 
OKX_SYSTEM_ITEMS_V.
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� Ensuring that Bill to Address, Ship to Address, and Customer Account rule 
types are associated with the category.

Seed Data
New seed data for this operation includes the following:

� New Process (API) Definition for Sales integration.  From the Contracts 
Manager responsibility, navigate to Setup > Contract Process Definition. 

� OKC_OPERATION_PURPOSE new lookup with the following values:

� INTEGRATION

� EXECUTION

�  OKC_RULE_DEF lookup has new value:

� EXL_OPN: Operation Exclusion. This rule is used in contract authoring to 
exclude any integration operation that user may not  want for contract.

� The Concurrent Program "Order creation from Contract" has added a parameter 
for selecting a contract category from an LOV. 

Messages
The following table shows sample messages associated to this process:

Name Description

Process Name QA FOR KTO INTEGRATION

Description API to enforce Rules of KTO

Purpose Quality Assurance

Type PLSQL

Package OKC_SALES_CLASS_QA

Procedure VALIDATE_KTO_INTEGRATION

Message Name Message

OKC_K2O_LS_
SOURCE_TABLE

Line item is not from Inventory master. Please check the source 
view of JTF Object & JTF_OBJECT. JTF Objects from_table 
should be  &VIEW
3-10 Oracle Sales Contracts



Setting Up Contract to Order
Upgrades
To upgrade a contract which does not belong to a category eligible for integration 
with Order Management the following steps can be followed:

1. Associate Operation "Integration with Order Management" with category 
whose contract needs to be made eligible for integration. Use Status and 
Operations form for this.

2. Associate Rule group "Operation Exclusion" to this category. This step may not 
be needed if you are sure that all the contracts in this category are intended to 
be integrated with Order Management. 

3. These steps will make Contract eligible to appear on the KTO Concurrent 
Program but successful creation of the order will depend on this contract 
passing the QA Checks associated with the integration operation.

OKC_K2O_SUPPLIER There are more than one parties which are sourced from table 
OKX_ORGANIZATIONS_DEFS_V/OKC_LEGAL_ENTITIES_V. 
Cannot decide which one is seller. There should be only one 
party with above source.

OKC_K2O_CUSTOMER1 There are more than one parties which are sourced from OKX_
PARTIES_V and there is no "Customer Account" rule. Cannot 
decide who is customer.Please remove one of the party with 
above usage or attach one customer account rule at Contract 
Header.

OKC_K2O_CUSTOMER2 There are more than one parties which are sourced from OKX_
PARTIES_V and there are more than one "Customer Account" 
rule.Cannot decide who is customer. Please remove one of the 
party with above usage or remove one customer account rule.

OKC_K2O_CUSTOMER3 There is no party which is sourced from OKX_PARTIES_V. 
Please select correct party or check the from_table of JTF Object 
of Party source.

OKC_K2O_SUBLS_
SOURCE_TABLE

Subline Style Source & JTF_OBJECT for service items should be 
sourced from either of OKX_PRODUCT_LINES_V or OKC_
COVERED_LINES_V or OKX_CUSTOMER_PRODUCTS_V

OKC_K2O_EXL_RULE Contract has exclusion rule for operation KTO.Order cannot be 
created.

Message Name Message
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3.4 Setting Up Order to Contract
Use this procedure for setting up Sales Contracts for Order to Contract.

3.4.1 Setting Up the Article

Steps
1. Review and set up the following profile options as needed:

2. From the Contracts Navigator (N) Contract > Setup > Standard Articles > 
Define Articles.

3. Enter the article name.

4. Select an appropriate subject name.

5. Enter your initial release version.

6. Enter the effective date.

7. Enter a short description.

8. Click the Article Sets tab.

9. Associate the standard article to an article set.

10. Click the Releases tab.

11. Click Release Text.

12. Enter the standard article text.

13. Save your work. You should see the article name within the article set in the 
tree.

User Profile Required/Optional

OKC: Contract template for standard terms and 
conditions

Required

OKC: Notification required for contract administrator Optional

OKC: Default group for contracts created from quote Optional

OKC: Default contract administrator for notifications Optional
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3.4.2 Setting Up the Template

Steps
1. From the Contracts Navigator, (N) Launch Contracts > Open > Tools > New.

2. Select the Create a New Contract Manually option.

3. Select the Sales Contracts as the Category.

4. Click Create.

5. Select Intent.

6. Click the Articles tab.

7. Select the Standard check box.

8. Select your Article. 

9. (N) Actions > Save as template.

10. Enter the template name.

11. Switch responsibilities to System Administration.

Associate the template created with profile option “OKC: Contract template for 
standard terms and conditions”. This is a mandatory step.

12. (N) Profiles > System.

13. Select the Template name just created as Value for Profile Option “OKC: 
Contract template for standard terms and conditions.

Associate the Contract Group with the profile option “OKC: Default group for 
contracts created from quote”. Associate the Contract Administrator with the profile 
option “OKC: Default contract administrator for notifications”. These steps are 
optional.

14. Select the Contract Group as value for Profile Option “OKC: Default group for 
contracts created from quote” 

15. Select the Administrator Name as value for Profile “OKC: Default contract 
administrator for notifications.
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